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КЕРІВНИК КУРСУ 
 

ПІП: к.п.н. Цідило Ірина Ігорівна 

Контактна 

інформація: 
i.tsidylo@wunu.edu.ua 

ОПИС ДИСЦИПЛІНИ 

Метою вивчення дисципліни «Комп’ютерна графіка та анімація» є сторення та 

художня обробка зображень, які відіграють роль ілюстраційного матеріалу до друкованих 

та електронних видань, дизайнерських розробок, рекламного оформлення, творів мистецтв; 

практичне оволодіння графічними редакторами з метою створення професійних зображень. 

Завдання вивчення дисципліни: знайомлення здобувачів вищої освіти з принципами 

растрової та векторної графіки та основними прийомами роботи з ними; формування 

уявлення про роботу з програмами векторної та растрової графіки; навчання  основним 

прийомам обробки растрових та векторних зображень; освоєння художньо-виражальних 

особливостей комп’ютерних інструментів. 

 
 

СТРУКТУРА КУРСУ 

Години 

(лек. 

/ 

лабор.

) 

Тема Результати навчання Завдання 

Змістовий модуль 1.  РАСТРОВА ГРАФІКА 

СИЛАБУС КУРСУ 

КОМП’ЮТЕРНА ГРАФІКА ТА АНІМАЦІЯ 

Галузь знань: 02 «Культура і мистецтво» 

Спеціальність: 022 «Дизайн» 

Ступінь вищої освіти: перший (бакалаврський) 

Освітньо-професійна програма: «Графічний дизайн» 

Рік навчання: ІІІ 

семестр: V, VI 

Кількість кредитів: 9 

мова викладання: українська 
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1 /2 

Тема 1. 

Вступ. 

Інтерфейс. 

Створення 

документів 

 

Знати: роль растрової графіки в дизайні та 

сучасному світі загалом. Приклади використання 

растрової графіки як носія інформації. Сфери 

використання растрової графіки. Джерела 

отримання та способи створення растрових 

зображень. . Роль растрової графіки в обробці 

зображень. Корекція та ретуш зображень, 

колажування.  Будова растрової графіки. Поняття 

пікселя. Переваги й недоліки растрової графіки. 

Інтерфейс. Інструменти, палітри, команди меню. 

Робочі простори. Робота з документами. Формати 

графічних файлів. 

Вміти:  створення нового документа 

(налаштування вікна), відкриття існуючого 

документа. Збереження документа в рідний формат 

.psd, плюс основні растрові формати: .jpg, .png. 

Робота з полотнами (Artboards). Робота з 

напрямними, створення, відображення. View > New 

Guide Layout. Як відкрити растровий файл в 

окремому документі і як розмістити в існуючому 

документі. Масштаб відображення документа. 

Навігація документом. 

Творче 

завдання 

- / 2 

Тема 2. 

Скасуванн

я дій. 

Розміри 

зображень. 

Трансфор

мація 

Знати: Система скасування дій. Розмір 

зображення. Фізичний та логічний розміри 

зображення. Розрахунок необхідного розміру 

зображення. Основні одиниці виміру.  

Вміти: Зміна розмірів зображення. Поняття 

ресамплінгу. Алгоритми ресамплінгу. Артефакти 

ресамплінгу. Зміна розмірів і поворот полотна. 

Кадрування зображення. 

Творче 

завдання 

- / 2 

Тема 3. 

Інструмент

и 

виділення 

 

Знати: Виділення. Призначення виділення. 

Інструменти виділення за формою. Інструменти 

виділення за кольором. Переміщення і 

трансформація виділених областей. Модифікація та 

трансформація виділення. Виділення по каналах. 

Інструмент «Перо» (Pen Tool).    

Вміти: Використання інструменту «Перо» 

для точних виділень. Заливка й обмалювання 

Творче 

завдання 
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виділених областей. Логічні операції з виділенням. 

Заливка з урахуванням вмісту 

 

1 / 2 Тема  4. 

Теорія 

кольору. 

Заливка та 

градієнт 

Знати: Теорія кольору. Поняття колірного 

каналу. Колірні моделі та колірні режими 

растрових зображень. Колірний обхват і глибина 

колірного каналу. Колірні канали. Поняття 

плашкового кольору. Вибір кольору. Основні 

робочі кольори. Інструменти заливки. Поняття 

градієнтної заливки.  

Вміти: Створення та використання 

градієнтних заливок. Плавні та шумові градієнтні 

заливки. Інструмент Pattern Stamp. Поняття патерну 

(візерунок). 
 

Творче 

завдання 

1 / 2 

Тема 5. 

Шари та 

режими 

накладанн

я 

 

Знати: Концепція шарів. Організація шарів. 

Створення. Групування шарів. Прозорість у шарах. 

Злиття шарів. Режими накладання. На які групи 

діляться, як використовуються. 

Вміти: Робота з шарами.  
 

Творче 

завдання 

1 / 2 
Тема 6. 

Інструмент

и 

малювання 

 

Знати:  Інструменти малювання Brush і Pencil. 

Параметри інструментів. Панель налаштувань. 

Установка сторонніх пензлів. 

Вміти: Якщо є наявні графічні планшети, 

рекомендується їх використовувати на цій парі. 
 

Творче 

завдання 

1 / 2 

Тема 7. 

Маски 

виділення. 

Маски 

шару 

Знати: Недоліки простих методів виділення. 

Часткове й розмите виділення. Команда Select > 

Color Range як приклад часткового виділення. 

Швидка маска. Створення складних виділень. 

Альфа-канали як засіб фіксування та збереження 

виділень. Растрова маска шару.  

Вміти: Використання маскування як 

Творче 

завдання 
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альтернатива видалення вмісту шару. Складні 

виділення. Використання Select and Mask для 

виділення волосся зі складного фону. Object 

Selection Tool. 
 

1 / 2 

Тема 8. 

Векторні 

можливост

і 

Знати: Векторні можливості. Геометричні 

фігури.  

Вміти: Робота з фігурами та використання 

режимів: Shape (вектор), Path (контур), Pixels 

(растр). Їхні особливості. Робота з контурами. 

Векторна маска шару. 
 

Творче 

завдання 

1 / 2 
Тема 9. 

Робота з 

текстом 

 

Знати: Поняття текстового шару. 

Налаштування тексту. Палітри Character і 

Paragraph. Ефект Text Warp.  

Вміти: Розташування тексту вздовж кривої. 

Перетворення тексту на криві. Як встановлювати 

шрифти. Де брати ліцензійні доступні шрифти. 
 

Творче 

завдання 

1 / 2 

Тема 10. 

Стилі 

шару 

 

Знати: Стилі шару.  

Вміти: Установка сторонніх стилів. Приклади 

використання (наприклад, у вебдизайні для 

створення кнопок – UI kit). 

Творче 

завдання 

1 / 2 

Тема 11. 

Тональна 

корекція. 

Колірна 

корекція 

Знати: Корекція зображень. Поняття 

гістограми.  

Вміти: Тональна корекція. Колірна корекція. 

Творче 

завдання 

1/ 2 
Тема 12. 

Динамічні 

шари 

 

Знати: Створення шарів заливки та 

коригувальних шарів.  

Вміти: Використання в колажуванні. 

 

Творче 

завдання 
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1 / 2 

Тема 13. 

Смарт-

об'єкти 

Знати: Створення та використання смарт-

об'єктів. Створення Mockup.  

Вміти: Маріонеткова деформація. 

Творче 

завдання 

1 / 3 
Тема 14. 

Інструмент

и ретуші 

 

Знати: Інструменти ретуші. Інструменти 

корекції. History Brush («Художній архівний 

пензель»).  

Вміти: Частотне розкладання. Використання 

нейрофільтрів Neural Filters. 
 

Творче 

завдання 

1 / 3 

Тема 15. 

Фільтри 

 

Знати: Фільтри. Filter Gallery. Комбінування 

декількох фільтрів для створення складних ефектів.  

Вміти: Використання фільтрів для 

стилізації зображень. Використання фільтрів 

Photoshop для ретуші. Фільтр «Пластика». 

Творче 

завдання 

1 / 3 

Тема 16. 

Піксель-

арт 

 

Знати: Піксель-арт. Прийоми і правила 

створення зображень з надмалою роздільністю. 

Інструменти Pencil, Single Column Marquee, Single 

Row Marquee.  

Вміти: Створення та підготовка піксель-арт 

зображення до покадрової  

Творче 

завдання 

1 / 3 
Тема 17. 

Matte 

Painting 

 

Знати: Photobashing. Етапи створення 
зображення за допомогою Matte Painting. 
Концепція та вибір зображень для роботи. 

   Вміти: Розташування зображень та їхня 
обробка. Малювання тіней та глобальне 
освітлення. Маріонеткова деформація. 

Творче 

завдання 

1 / 3 
Тема 18. 

Анімація 

 

Знати: Палітра Timeline. Принципи анімації. 

Покадрова анімація. Анімація за ключовими 

точками.  

 Вміти: Створення анімованого банера. 
 

Творче 

завдання 
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1 / 3 

Тема 19. 

Плагіни та 

автоматиза

ція 

Знати: Оглядовий розгляд питання, які 
сторонні плагіни присутні на ринку (без установки 
на комп'ютер). Як домашнє завдання можна 
запропонувати встановити і випробувати їх у дії. 
Автоматизація дій. Поняття макрокоманди. Палітра 
Actions.   

 Вміти: Використання існуючих 
макрокоманд. Створення, управління, редагування 
макрокоманд. Група команд File > Automate. 
Пакетна обробка файлів. 

Творче 

завдання 

Змістовий модуль 2. ВЕКТОРНА ГРАФІКА   

 

1 / 3 
Тема 1. 

Вступ. 

Інтерфейс. 

Створення 

документів 

Знати: будова, переваги та недоліки роль 
векторної графіки в дизайні; інтерфейс Adobe 
Illustrator; формати векторних графічних файлів; 
базові налаштування заливки та абрису; 
інструменти виділення. 

Вміти: працювати з документами та з 
монтажними областями, з графічними 
примітивами.  

Творче 

завдання 

1 / 3 
Тема 2. Робота 

з об’єктами 

Знати:  інструменти виділення об’єктів; 

налаштування програми, пов’язані з виділенням 

об’єктів та з переміщенням об’єктів;  копіювання та 

вставка; групування; вирівнювання та розподіл 

об’єктів;  панель Transform; лінійки, напрямні та 

сітка.  

Вміти: малювати контури довільної форми та 

виконувати трансформацію об’єктів.   

 Творче 

завдання 

 

1 / 3 

Тема 3. Криві 

Безьє. Робота з 

контурами 

Знати: Копіювання та клонування контурів. 

Групування контурів. Логічні операції з контурами. 

Основні логічні операції. Додаткові операції з 

контурами. Панель Pathfinder. Операції з 

контурами. Інструмент Eraser. Інструмент Scissors. 

Інструмент Knife. Команда Divide Objects Below. 

Вміти: працювати з контурами.  

 Творче 

завдання 

 

1 / 3 
 

Тема  4. 

Трасування 

Знати: трасування; імпорт растрових 

зображень в Adobe Illustrator; пов’язані зображення; 

контейнери для зображень; відсічні маски. 

автоматичне та ручне трасування.  

Вміти: виконувати автоматичне  та ручне 

Творче 

завдання 
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трасування.   

 

 

1 / 3 

 

Тема  5. 

Заливка 

Знати: заливка; суцільні заливки; 

призначення довільного кольору; зразки кольорів; 

локальні та глобальні зразки кольору; бібліотеки 

зразків; колірні групи; градієнтні та візерункові 

заливки; команда Recolor Artwork; способи 

перефарбування зображень.  

Вміти: створювати зразки заливки; власний 

зразок візерунка; трансформувати візерункові 

заливки; перефарбувати зображення.  

 

Творче 

завдання 

 

 

1 / 3 

 

 

Тема  6. Абрис  

(Обведення) 

Знати: абрис (обведення); параметри абрису; 

пензлі Adobe Illustrator та їх види; забарвлення 

пензлів. 

Вміти: створювати та застосовувати  

каліграфічні, дискретні, художні,  візерункові 

пензлі.  

 

Творче 

завдання 

1/ 4  

 

Тема 7. Текст 

Знати: текст; види та налаштування тексту; 

інструмент «Коригування тексту»;  фрейми 

довільної форми; перетікання тексту між 

фреймами; обтікання текстом графічних об’єктів;  

імпорт та експорт тексту; перевірка орфографії; 

пошук і заміна елементів у тексті; розміщення 

тексту вздовж контуру. 

Вміти: створювати, редагувати  форматувати 

текст; працювати з текстом у фреймах. 

 

Творче 

завдання 
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1 / 4 
 

 

 

 

 

Тема  8. 

Шари 

Знати: шари, призначення панелі шарів; 

перейменування шарів, об’єктів і груп об’єктів;  

атрибути шару; параметр Color; операції з шарами 

й об’єктами всередині шарів; вкладені шари; 

виділення об’єктів на панелі шарів; відсічна маска; 

шаблонні шари; режим ізоляції; копіювання і 

вставка шарів в інший документ.  

Вміти: створювати шари заливки та 

коригувальні шари; створювати новий шар; 

використовувати шари в колажуванні. 

Творче 

завдання 

1 / 4 
Тема  9. 
Прозорість і 
градієнтні сітки 

Знати: прозорість і непрозорість, маски 
непрозорості; режими накладання;  способи 
додавання прозорості об’єктів і зображень;  
градієнтні заливки з прозорими ділянками; панель 
Transparency; градієнтні сітки.  Інструмент Mesh 
Tool.  

Вміти: призначати прозорість за допомогою 
панелі Appearance; створювати градієнтну сітку; 
перетворювати об’єкт з градієнтною заливкою на 
сітчастий об’єкт; створювати сітчастий градієнт за 
допомогою команди меню Object > Create Gradient 
Mesh; редагувати сітчасті градієнти; призначати 
колір вузлам сітчастого градієнта; комплексно 
перефарбувати сітчастий градієнт; додавати контур 
до сітчастого об’єкта; створювати об’єкт за формою 
сітчастого градієнта. 

Творче 
завдання 

1 / 4 Тема 10. 
Символи та 
графічні стилі 

Знати: символи та графічні стилі;  панель 

Symbols;   Symbol Sprayer Tool (Розпилення 

символів); інструменти редагування масиву 

символів; Налаштування Symbol Sprayer Tool й 

інструментів редагування масиву символів; 

інструменти: . Symbol Shifter Tool, Symbol 

Scruncher Tool,  Symbol Sizer Tool, Symbol Spinner 

Tool, Symbol Stainer Tool, Symbol Screener Tool, 

Symbol Styler Tool; графічні стилі;  стилі. 

Вміти: створювати зразки символів у 

документі;  модифікування зразки символів; 
створювати власні символи; додавати символи в 

Творче 

завдання 
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ілюстрацію; замінювати символи; створювати 
нові символи; працювати з динамічними 
символами; зберігати бібліотеки символів; 
присвоювати об’єкту декілька обведень і заливок. 

1 / 4 
Тема  11. 

Ефекти й 

фільтри 

Знати: ефекти й фільтри; переходи кольорів і 

контурів; інструмент Blend і його налаштування; 

перехід уздовж контуру; векторні фільтри й ефекти; 

перетворення, дублювання, видалення ефектів; 

особливості застосування векторних ефектів на 

піксельних зображеннях; особливості застосування 

векторних ефектів на векторних контурах; види 

векторних ефектів; ефекти взаємодії й обробки 

контурів; ефекти трансформації та спотворення; 

ефекти тіні, світіння та розтушовування; 

використання тривимірних ефектів: Rotate, Extrude 

and Bevel, Revolve. 

Вміти: застосовувати ефекти до зображень. 

 

Творче 

завдання 

1 / 4 
Тема  12. 

Створення 

зображень у 

стилі Paper Gut 

Знати: стиль Paper Cut; етапи створення 

ілюстрації Paper Cut. 

Вміти: створювати зображення у стилі Paper 

Cut. 
 

Творче 

завдання 

 

1 / 4 
Тема 13. 

Створення 

зображень у 

стилі Low Poly 

Знати: стиль Low Poly; етапи створення 

ілюстрації Low Poly. 
Вміти: створювати зображення у стилі Low Poly  

Творче 

завдання 

 

1 / 4 
Тема  14. 

Растрова 

графіка 

Знати: растрова графіка; зв’язування і 

вбудовування растрових зображень; керування 

зв’язаними зображеннями; растрові ефекти. 

Вміти: застосовувати растрові ефекти до 

векторних об’єктів. 
 

Творче 

завдання 

 

 

РЕКОМЕНДОВАНІ ДЖЕРЕЛА ІНФОРМАЦІЇ 

Базова література: 

1. Веселовська І., Ходаков Є., Веселовська О. Комп’ютерна графіка, Харків 2013, 345 с. 
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ПОЛІТИКА ОЦІНЮВАННЯ 

Оцінка за поточне оцінювання визначається як середнє арифметичне з оцінок 

отриманих під час занять  (кожен здобувач має бути оцінений не рідше як раз на два 

заняття). Пропуски  практичних (лабораторних) занять обов’язково відпрацьовуються в 

години консультацій, в іншому випадку вони вважаються оцінкою “0” та враховуються 

при визначенні середнього арифметичного. Для здобувачів, які навчаються за 

індивідуальним графіком, поточне оцінювання проводиться під час консультацій та 

шляхом виконання завдань в системі Moodle. Модульний контроль планується на 

половині проведених занять. Модульний контроль проводиться в системі Moodle в 

позааудиторний час. 

 

КРИТЕРІЇ, ФОРМИ ПОТОЧНОГО ТА ПІДСУМКОВОГО КОНТРОЛЮ 

 

Підсумковий бал (за 100-бальною шкалою) з дисципліни «Комп’ютерна графіка та 

анімація» Змістового модулю 1. РАСТРОВА ГРАФІКА визначається як середньозважена 

величина, залежно від питомої ваги кожної складової залікового кредиту: 

Модуль 1 Модуль 2 Модуль 3 Модуль 4 

    

20% 20% 20% 20% 5% 15% 

Поточне 

оцінювання 

Модульний 

контроль 1 

Поточне 

оцінювання 

Модульний 

контроль 2 
Тренінги 

Самостійна 

робота 

1. Оцінка за поточне 

оцінювання визначається 

як середнє арифметичне 

1. Оцінка за поточне 

оцінювання визначається 

як середнє арифметичне 

Перегляд  

демонстраційних 

та 

презентаційних 

Створення 

демонстраційної 

графіки курсу. 

 

http://dspace.tnpu.edu.ua/handle/123456789/29320
https://www.abebooks.com/servlet/SearchResults?an=wood%20brian&cm_sp=det-_-plp-_-author
https://www.abebooks.com/book-search/publisher/pearson/
https://moodle.wunu.edu.ua/course/view.php?id=9447
https://moodle.wunu.edu.ua/course/view.php?id=9448
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з оцінок, отриманих під 

час занять  

2. Оцінка за Модульний 

контроль 1 виставляється 

на підставі виконання  

практичних завдань 

з оцінок, отриманих під 

час занять  

2. Оцінка за Модульний 

контроль 2 виставляється 

на підставі виконання  

практичних завдань 

матеріалів курсу 

 

 

Підсумковий бал (за 100-бальною шкалою) з дисципліни «Комп’ютерна графіка та 

анімація» Змістового модулю 2. ВЕКТОРНА ГРАФІКА визначається як середньозважена 

величина, залежно від питомої ваги кожної складової екзаменаційного кредиту: 

 

Шкала оцінювання: 

 
За шкалою 

ЗУНУ 

За національною 

шкалою 
За шкалою ECTS 

90–100 відмінно А (відмінно) 

85–89 добре В (дуже добре) 

75-84 С (добре) 

65-74 задовільно D (задовільно) 

60-64 E (достатньо) 

35-59 незадовільно FX (незадовільно з можливістю повторного 

складання) 

1-34 F (незадовільно з обов’язковим   

повторним курсом) 

 

. 

Критерії оцінювання проєктного завдання з комп’ютерної графіки 

Модуль 1 Модуль 2 Модуль 3 Модуль 4 Модуль 5 

10% 10% 10% 10% 5% 15% 40% 

Поточне 

оцінювання 

Модульний 

контроль 1 

Поточне 

оцінювання 

Модульний 

контроль 2 
Тренінги 

Самостійна 

робота 

Екзамен 

1.  Оцінка за поточне 

оцінювання визначається 

як середнє арифметичне з 

оцінок, отриманих під час 

занять  
 

2. Оцінка за Модульний 

контроль 1 виставляється 

на підставі виконання  

практичних завдань 

Оцінка за поточне 

оцінювання визначається 

як середнє арифметичне з 

оцінок, отриманих під час 

занять  

2. Оцінка за Модульний 

контроль 2 виставляється 

на підставі виконання  

практичних завдань 

Перегляд  

демонстраційних 

та презентаційних 

матеріалів курсу 

 

Створення 

демонстраційної 

графіки курсу. 

 

Оцінювання 

фінального 

проєкту 
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Характеристика рівнів  проєктних завдань з комп’ютерної графіки 

 

 

За 

шкалою 

ЗУНУ 
Характеристика рівнів виконаних завдань 

90-100 Точно визначено та узгоджено тонально-колірні параметрами 

зображення та прозорість шарів. Застосовано особливу систему 

ефектів в монтажних переходах; застосовано точно керовані 

ефекти; виконано коректно трансформації зображення, його 

форми, кольору або фактури. Можливо, створено тривимірні 

об’єкти,  поєднано з будь-якими відзнятими зображеннями. 

Відредаговано виразність написання шрифтів. Збережено  

можливість запам’ятовувати складні процедурні послідовності 

перетворень зображення. Виявлено якісні характеристики 

художнього образу. Відібрано необхідну (за можливості 

найменшу) кількість значущих для змісту компонентів 

майбутнього твору,  вибудовано їх структурні взаємозв’язки. 

Створено набір виражальних засобів, адекватних інформаційному 

змісту та образ, який у концентрованому вигляді є сенсом 

повідомлення. Знайдено  композиційний прийом, що дозволяє 

тому, хто сприймає, освоювати необхідну для нього інформацію . 

Назва критерію Характеристика критерію 

 ціннісно-цільовий переклад (інформування) 

 художній  володіння основами образотворчої 

грамоти 

творчий  створення  (надання форми) 

технологічний  технологія цифрових зображень  

оцінювально-аналітичний артикуляція (пояснення ідей)  
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85-89 Визначено  та узгоджено тонально-колірні параметрами 

зображення та прозорість шарів. Застосовано систему ефектів в 

монтажних переходах; застосовано керовані ефекти; виконано  

трансформації зображення, його форми, кольору або фактури. 

Збережено  можливість запам’ятовувати складні процедурні 

послідовності перетворень зображення. Виявлено  характеристики 

художнього образу. Відібрано необхідну  кількість значущих для 

змісту компонентів майбутнього твору,  вибудовано їх структурні 

взаємозв’язки. Створено набір виражальних засобів, адекватних 

інформаційному змісту та образ. 

Знайдено  композиційний прийом. 

75-84 Визначено тонально-колірні параметрами зображення та 

прозорість шарів. Застосовано  ефекти в монтажних переходах; 

застосовано ефекти; виконано трансформації зображення. 

Збережено  можливість запам’ятовувати складні процедурні 

послідовності перетворень зображення. Виявлено  характеристики 

художнього образу. Відібрано необхідну  кількість значущих для 

змісту компонентів майбутнього твору. Створено набір 

виражальних засобів, адекватних інформаційному змісту. Не 

знайдено  композиційний прийом, що дозволяє тому, хто 

сприймає, освоювати необхідну для нього інформацію . 

65-74 Неточно  визначено та узгоджено тонально-колірні параметрами 

зображення та прозорість шарів.  Застосовано  неточно керовані 

ефекти; виконано некоректно трансформації зображення, його 

форми, кольору або фактури. Збережено  можливість 

запам’ятовувати складні процедурні послідовності перетворень 

зображення. Не виявлено якісні характеристики художнього 

образу. Не відібрано необхідну  кількість значущих для змісту 

компонентів майбутнього твору, не вибудовано їх структурні 

взаємозв’язки. Створено набір виражальних засобів та образ, який 

у концентрованому вигляді не є сенсом повідомлення. Не знайдено  

композиційний прийом. 



1
5 

 

60-64 Неточно  визначено  тонально-колірні параметрами зображення та 

прозорість шарів. Не застосовано  точно керовані ефекти; не 

виконано  трансформації зображення, його форми, кольору або 

фактури. Збережено  можливість запам’ятовувати складні 

процедурні послідовності перетворень зображення. Не виявлено 

якісні характеристики художнього образу, не вибудовано їх 

структурні взаємозв’язки. Не створено набір виражальних засобів 

та образ, який у концентрованому вигляді є сенсом повідомлення. 

35-59 Не визначено тонально-колірні параметрами зображення та 

прозорість шарів. Не застосовано   керовані ефекти; не виконано  

трансформації зображення. Не збережено  можливість 

запам’ятовувати складні процедурні послідовності перетворень 

зображення. Не виявлено якісні характеристики художнього 

образу. 

1-34 Не визначено тонально-колірні параметрами зображення. Не 

застосовано   ефекти; не виконано  трансформації. Не збережено  

можливість запам’ятовувати складні процедурні послідовності 

перетворень зображення. 

Інструменти, обладнання та програмне забезпечення, використання яких 

передбачає навчальна дисципліна 
 

№ 

п/п 

Найменування Номер 

теми 

1 Мультимедійний проектор 

1-14 

1-19 

2 Проєкційний екран 

3 Комунікаційне програмне забезпечення (Google Chrome) 

4 Наявність доступу до мережі Інтернет 

5 Персональні комп’ютери, ноутбук. 

6 Комунікаційне програмне забезпечення (Zoom) для 

проведення занять у режимі он-лайн (за необхідності) 

7 Комунікаційна навчальна платформа (Moodle) для організації 

дистанційного навчання (за необхідності) 

8 Програмне забезпечення: ОС Windows 

9 Інструменти Microsoft Office (Word; Excel; Power Point і т. і.) 


